Document/Presentation Accessibility Best Practices 19-Oct-15
Microsoft Word 2013, PowerPoint 2013, Excel 2013 and Adobe PDF
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Key Terms

Accessible/Accessibility

A document is accessible if it can be read by a screen reader in the proper order. A video is
accessible if it is captioned. Audio is accessible if it has a transcript.

Alternative Text

Alternative Text (Alt Text) is a description of a graphic / picture. When a screen reader (JAWS) comes
upon a graphic, it will announce that it is a graphic. Unless there is alternative text, the user will not
know what the graphic is or why it is there.

Job Access with Speech (JAWS)

JAWS is a text-to-speech screen reader program. Users who are blind use this software to navigate
the internet, Word and PDF documents, and other computer programs by only using the keyboard.
Screen readers are also used by individuals with learning disabilities. A JAWS user can better
navigate the Internet, Word, PowerPoint, Excel and PDF documents if they contain Headings,
alternative text, and properly labeled links. JAWS reads documents from top to bottom, left to right.

Optical Character Recognition (OCR)

OCR is the electronic conversion of images to recognizable text. When users scan a document, the
document is saved as an image. Once OCR has been performed, documents can be read by text to
speech programs and text can be copied and pasted. The text will also be searchable.

Screen Reader
A text-to-speech program that allows the user to listen to what is on the screen.

Usable

A document may be accessible because a screen reader can read it, but it may not be usable
because a screen reader user may not be able to easily navigate through the document. By giving a
document Headings, alt text for graphics, and properly labeled links, the document will be accessible
and usable.
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Microsoft Word

Properly format headings to structure documents.

1. Highlight the text you want to use as a heading.
2. Click “Home” on the Microsoft Word ribbon.

3. Right-click Heading 1 (or 2, or 3).

4. Select “Update Heading to Match Selection”.
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Add alternative text (alt text) to images.

Right-click the picture.

Click “Format Picture”.

Click the “Layout & Properties” icon.

Type detailed alt text in the “Description” textbox.

PwnhE

Format Picture
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l: TEXT BOX

4 ALT TEXT
Title ©

Description

Screen shot of the Microsoft Word -«
toolbar, The Home tab is selected,
Heading 1 is highlighted and has
been right-clicked, causing a
dropdown menu to appear.
“Update Heading 1 to Match
Selection” is selected, The
highlighted word in the body of
the Ward document will herame a

m

Properly label links with meaningful descriptions.

1. Type the description of the hyperlink.
a. Ex. University of South Carolina Center for Excellence

2.
3.
4.
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Highlight the description and then right-click.
Select “Hyperlink”.
Enter the web address in the “Address” box.



5. In the “Text to Display” box, include the URL in parentheses after the description.
6. Click “OK”.

Insert Hyperlink I

Link to: Text to display: University of South Carolina Center for Excellence (www.sc.edu/cte]|
L) Look in: Accessibility E| D

Existing File
or Web Page ﬁ: 2015-Roadmap-to-Web-Accessibility-in-Higher-Education ~ » Bookmark...
| | S&ent |95 sColleges-Brief i
1= 7 ways to make your class accessible =
ﬁ. 7_ways_class_accessible
= Accessibility for Website
& M= Accessibility Guide Ideas
Create New Recert M= Accessibility Notes
Document Files |@Z| accessibility_how_to_guide
] accessibility_how_to_guide

Place in This
Document Browsed
Pages

:_ﬂ Address: http:// www.sc.edu/cte
E-mail
Address

][ Cancel ]

University of South Carolina Center for Excellence (www.sc.edu/cte)

Use pre-formatted list styles when making lists.

1. Select the text that should be made into a list.
2. Click “Home” on the Microsoft \Word ribbon.
3. Select the “Bullets” or “Numbering” icon.

*Numbered lists should be used if order is important.

Bookmark tables.

If your table has only column headings, place the insertion point in any one cell within the row
containing the headings.

Click “Insert” on the PowerPoint ribbon.
Click “Bookmark”.

Type ColumnTitle.

4. Press “Enter”.

wnN e

*Bookmarking one column title will bookmark all columns in a table.
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3
Demographic Variable| Physically Disabled Comparison
(n=566) (n=460)
Age, M (SD) 50.8 (13.8) 51.3 (13.6)
Years education, M (SD) 10.5 (3.0 12.3 (3.5)

Bookmark @Iﬁ‘ gg
Bookmark name: 80
ColumnTitle [ Add ] 11
i

*For each additional occurrence of a table that uses a Column Title, change the name of the
bookmark by adding _2, 3, etc. after the additional occurrence.

Example:
e ColumnTitle_2 (second occurrence of a Column Title in another table).
e ColumnTitle_3 (third occurrence of a Column Title in another table).

If your table has only row headings, place the insertion point in any cell within the column containing
the heading.

1. Click “Insert” on the PowerPoint ribbon.
2. Click “Bookmark”.

3. Type RowTitle.

4. Press “Enter”.

*Bookmarking one row title will bookmark all rows in a table.

B3
Name| Joe Taylor Ashley
Birthdate 1-12-76 7-31-80 12-7-80
Sex Male Female Male
Bookmark M 3.5 35
Bookmark name:
RowTitle] Add

*For each additional occurrence of a table that uses a Row Title, change the name of the bookmark
by adding 2, 3, etc. after the additional occurrence.

Example:
e RowTitle_2 (second occurrence of a Column Title in another table).
e RowTitle_3 (third occurrence of a Column Title in another table).
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If your table has both row and column headings, place the insertion point in a cell where the row
and column meet.

Click “Insert” on the PowerPoint ribbon.
Click “Bookmark”.

Type Title.

Press “Enter”.

NP

Joe Jill Ann
March 5 4 4
rAt:)ril 3 3

Bookmark ]\ij_-ﬁ;] 5

Bookmark name:
Title| Add

*For each additional occurrence of a table that uses a Title, change the name of the bookmark by
adding 2, 3, etc. after the additional occurrence.

Example:
e Title_2 (second occurrence of a Column Title in another table).
e Title_3 (third occurrence of a Column Title in another table).

Indicate column headers for tables.

Place the cursor in the first row of the table.
Click “Design” under “Table Tools”.

Make sure that “Header Row” is selected.
Click “Layout” under “Table Tools”.

Click “Repeat Header Row”.

aprwNE

HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW DESIGN LAYOUT

¥ Header Row  |¥| First Column § ) ) - 4

Total Row Last Column SEEEEl | ====5 =E==s ===== cfzz: zzzzz fzz:- |- Yapt - -
CEEEE] | EESEE] EEEEsl ===—== -lF=Z-Z Z-ZZZC ZI=ZZ2 2 [Z Shading Border' —; Borders Border
| Banded Rows Banded Columns - . Styles r_’ Pen Color - ~  Painter
Table Style Options Table Styles Borders [
[ 1 8 1 2 g 3 4 B s 3 #
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Repeat Header Rows
Mark multiple rows as header rows.
If your table spans multiple pages

the header rows will appear on

every page for easy reference.

Check the reading order of tables by pressing the “Tab” keyboard key.

Screen readers read a table from left to right, and then top to bottom.

1. Place the cursor in the first cell in the table.
2. Press the “Tab” key on your keyboard to display the reading order of the table.

Use sufficient color contrast.

It is important for there to be enough color contrast between background colors and text in
documents. Many users may have difficulty perceiving text if there is too little contrast between
background colors and text.

Visit the WebAim Color Contrast Checker (http://webaim.org/resources/contrastchecker/) page to
check your color contrast.

Do not use color alone to convey messages.

Users with visual impairments, such as color blindness, may not be able to understand the content
being presented if color alone is used to convey messages. Additionally, if information is printed
using a black and white printer, the message will not be conveyed.

Use san-serif fonts.

The type of font used in documents can make it easier or more difficult for a visually impaired person
to read the material. The best fonts to use are san-serif fonts (ex. Arial, Verdana, Helvetica,
Tahoma, Antique Olive).

Microsoft PowerPoint

Use the provided PowerPoint slide layouts.

1. Click “Home” on the PowerPoint ribbon.
2. Click “New Slide”.
3. Select a theme.
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*Using the provided PowerPoint slide layout helps you keep the reading order intact.

HOME INSERT DESIGN TRANSITIONS ANIMATIONS J
| 7‘ [:=] Layout ~
“*) Reset
New _ B U
Slidev ) Section~
board « | Office Theme
Title Slide
Two Content Comparison Title Only
Blank Content with Picture with
Caption Caption

Check the reading order of slide contents.

1. Select the slide without clicking information on the slide.
2. Press Tab on your keyboard.

To modify slide placeholders,

Click “Home” on the PowerPoint ribbon.

Click “Arrange”.

Click “Selection Pane”.

The last item will be read first. To change the order, select the item and the click up or down
arrow icon.

rwpnE
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Add alternative text to images and shapes.

1. Right-click the image.
2. Click “Format Picture”.
3. Click the “Size & Properties” icon.
4. Click “Alt text”.
5. Enter alternative text in the “Description” textbox.
Format Picture kg
OO =
b SIZE
b POSITION
P TEXT BOX
4 ALT TEXT
Title ©
Description
Umbrella with Gamecock logo.

Properly label links with meaningful descriptions.

1. Type the description of the hyperlink.
a. Ex. University of South Carolina
Highlight the description and then right-click.
Select “Hyperlink”.
Enter the web address in the “Address” box.
In the “Text to Display” box, include the URL in parentheses after the description.
Click “OK”.

ook wh
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University of South Carolina (www.sc.edu)

™
Edit Hyperlink L9 )
Link to: Text to display: University of South Carolina (www.sc.edu)
j Look in: ‘| Documents TE;
Existing File B D D D
or Web Page Getting_Started_with_Adobe_Presenter-2 - Bookmark...
CF%rlrde:'t IVONA Reader Documents
IVONA Reader Podcasts
Place in This Lynda
Document Browsed . =
Pages My Adobe Presentations
) My Adobe Presenter Video Projects
Create New Recent My Adébe Presen‘ter Video Projects Published
Document Files My Articulate Projects
| (&) My Data Sources M
'_1] Address: http://www.sc.edu/ E] Remove Link
E-mail
Address
l OK ] [ Cancel ]

Use pre-formatted list styles when making lists.

1. Select the text that should be made into a list.
2. Click “Home” on the PowerPoint ribbon.
3. Select the “Bullets” or “Numbering” icon.

*Numbered lists should be used if order is important.

Set videos to start automatically.

Insert your video.

Select your video.

Click “Playback” under “Video Tools”.

Click the down arrow next to “Start On Click”.
Select “Automatically”.

abrownpE

Indicate column headers for tables.

1. Place the cursor in the first row of the table.
2. Click “Design” under the “Table Tools”.
3. Make sure “Header Row” is selected.

@HEHS & B- Presentation2 - PowerPoint TABLE TOOLS
HOM RT DESIGN TRANSITIONS ANIMATIONS SLIDE SHOW REVIEW VIEW ADD-INS ADOBE PRESENTER POLL EVERYWHERE DESIGN LAYOUT

v| Header Row First Column | £ shading ~ A‘ A~ o] p—
Y ==
Total Row Last Column Borders ~ - 1pt -
= Quick = - Draw Eraser
V| Banded Rows [ | Banded Columns | =———— | QEffectst  gyyles A~ ZPenColors  opie

Table Style Options Table Styles WordArt Styles Draw Borders

Check the reading order of tables by pressing the “Tab” keyboard key.

Screen readers read a table from left to right, and then top to bottom.

1. Place the cursor in the first cell in the table
2. Press the “Tab” key on your keyboard to display the reading order of the table.
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Include unique titles for slides.

On the PowerPoint ribbon, click “View”.

Click “Outline View”.

Check your slide titles for uniqueness.

If you need to change a slide title, double click the bolded title and then type your information.

Normal QOutline Slide Notes Read
View Sorter Page Vie

PwnhPE

Presentation Views

1 PowerPoint 101
MY POWERPOINT

2 PowerPoint
1. Images
2. Graphs
3. Slideshows
4, Animations
5. Transitions

3 Word
1. Alt Text
2. Label Links
3. Tables
4, Shapes

4[] Excel
1. Columns
2. Rows
3. Images
4, Worksheets

Use sufficient color contrast.

It is important for there to be enough color contrast between background colors and fonts in
documents. Many users may have difficulty perceiving text if there is too little contrast between
background colors and fonts.

Visit the WebAim Color Contrast Checker (http://webaim.org/resources/contrastchecker/) page to
check your color contrast.

Do not use color alone to convey messages.

Users with visual impairments, such as color blindness, may not be able to understand the content
being presented if color alone is used to convey messages. Additionally, if information is printed
using a black and white printer, the message will not be conveyed.

Use san-serif fonts.

The type of font used in documents can make it easier or more difficult for a visually impaired person
to read the material. The best fonts to use are san-serif fonts (ex. Arial, Verdana, Helvetica,
Tahoma, Antique Olive).
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Microsoft Excel

Give column titles / column and row titles to spreadsheets.

Column Titles

Create your spreadsheet.

Click on the first cell in the row of column titles.
Click on the “Formulas” tab.

Click “Name Manager”.

Click “New”.

In the name field, type “ColumnTitle”.

7. Click “OK” and then “Close”.

o hrwNE

*If you are defining column titles for a worksheet other than worksheet 1, you must add the sheet
number into the formula. Example: "ColumnTitle2" for Sheet 2. "ColumnTitle3" for Sheet 3.

A B C D E F G
Date [~ | Topic| ~ Reading v
3/12/2015 Ethics Chapter 1 pp. 12-28
3/17/2015 Discourse Chapter 2 pp. 52-70
4/1/2015 Poetry Chapter 3 pp. 72-89,
VNarne Manager m‘
e | [ ear. | [ peme |
[ Name Value Refers To Scope Comment
g ColumnTitie _ Date _________=Tablel[¥Headers].. Workbo.. |
T Tablet {3/12/2015","Ethics... =Sheetl!SAS2SCS4  Workbo..,
Refers to:
=Tablel[[#Headers],[Date]] R

Column and Row Titles

Create your spreadsheet.

Click on the cell where the row and column intersect.
Click on the “Formulas” tab.

Click “Name Manager”.

Click “New”.

In the name field, type “Title”.

Click “OK” and then “Close”.

NoOA~ONE
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A B C

IAssignment 1 Assignment 2 Assignment 3 Assignment 4
=

D E F

=Sheetl!SASL

Mark Anthony 95 98 96 100
Jim Smith 100 45 96 67
Lisa Andrews 62 78 90 100
Jane Doe 100 100 95 100
Name Manager
[ New... [ Edit. ] [ Delete ] [ gitter~ |
[ Name Value Refers To Scope Comment |
lrte __ osheetiSaSt___ Workbo. ]

Specify Column Header Information

1. Click anywhere in the table.
2. Click the “Design” under the “Table Tools” tab.
3. Make sure that the “Header Row” check box is selected.

VIEW DESIGN

v Header Row
Total Row

v Banded Rows

If you are including new information as a table,

Click Table.

HwnE

TABLE TOOLS

First Column
Last Column
Banded Columns

Table Style Options

Highlight the information to be included in the table.
Click “Insert” on the Excel ribbon.

Make sure that “My table has headers” is checked.
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A B C D

Columbia | Orangeburg North ~  Bowman
95 98 96 100
100 45 96 67
62 78 90 100
100 100 95 100

p-
Create Table

Where is the data for your table?
=SAS1:5DS5

My table has headers

[ OK ][ Cancel ]

Add alternative text to images and objects.

1. Right-click the picture, click the “Layout & Properties” icon.
2. Type detailed alternative text in the “Description” textbox.

N 1 P Q R 1 U]

| Format Picture v
OO &

4 SIZE

Height 4.05°
Width 547
Rotation 0°
Scale Height 51%
Scale Width 51%
V| Lock aspect ratio

V| Relative to original picture size
Original size

Height 8" Width: 1067"

Reset

b PROPERTIES

b TEXT BOX

4 ALTTEXT
Title G

Description

Grey koala hanging from a tree.

Properly label links with meaningful descriptions.

1. Type the description of the hyperlink.

a. Ex. Learn more about Koalas.
2. Highlight the description and then right-click.
3. Select “Hyperlink”.
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4. Enter the web address in the “Address” box.
5. In the “Text to Display” box, include the URL in parentheses after the description.
6. Click “OK”.

[ ?
Insert Hyperlink L‘ﬁ
Link to: Text to display: more information about Koalas (https://en.wikipedia.org/wiki/Koala)
L) Lookin: | Documents E] D
Existing File
or Web Page . Lynda - Bookmark...
%%?:;t . My Adobe Presentations
: . My Adobe Presenter Video Projects
Place in This . My Adobe Presenter Video Projects Published
Document Browsed 5 .
Pages | - My Articulate Projects L
) (&) My Data Sources 1
Create New Recert , My Yonce Messages
Document Files . Physics
. Replay Telecorder N
= Address: | https:/en.wikipedia.org/wiki/Koala v
E-mail
Address

Learn more information about Koalas (https://en.wikipedia.org/wiki/Koala)

Avoid using blank columns, rows or blank cells for formatting.

Avoiding using columns, rows or blank cells for formatting because a screen reader user may think

that the table does not contain additional information.

Provide all sheet tabs unique names.

Including unigue names on sheet tabs provide information found within worksheets and makes it
easier to navigate through a workbook. Remove blank worksheets from a workbook.

1. Right click the sheet tab.
2. Click “Rename”.
3. Type the unique sheet name.
4. Click “Enter” on your keyboard.
40
41
42
Distributed Learning Pedagogy | Events ©
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Use sufficient color contrast.

It is important for there to be enough color contrast between background colors and fonts in
spreadsheets. Many users may have difficulty perceiving text if there is too little contrast between
background colors and fonts.

Visit the WebAim Color Contrast Checker (http://webaim.org/resources/contrastchecker/) page to
check your color contrast.

Do not use color alone to convey messages.

Users with visual impairments, such as color blindness, may not be able to understand the content
being presented if color alone is used to convey messages. Additionally, if information is printed
using a black and white printer, the message will not be conveyed.

Use san-serif fonts.

The type of font used in spreadsheets can make it easier or more difficult for a visually impaired
person to read the material. The best fonts to use are san-serif fonts (ex. Arial, Verdana, Helvetica,
Tahoma, Antique Olive).

PDF

Convert accessible Microsoft Office documents to accessible PDF documents.

Open the document that has already been made accessible.

Click “File”.

Click “Browse”.

Browse to where you want to save the document.

Click the arrow for “Save as type:”.

Click “PDF”.

Click “Options”.

Ensure that "Document structure tags for accessibility" is selected.
. Click “OK”.

10.Click “Save”.

©CoNoOkrwh R
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© A
Options m

Page range

@
) Current page

Selection
") Page(s) From: |1 = To: |1

Publish what
© Document
Document showing markup
Include non-printing information
[] Create bookmarks using:
@) Headings

Word bookmarks

[¥] Document properties /
{i] Document structure tags for accessibility

PDF options
["]150 19005-1 compliant (PDF/A)
[V] Bitmap text when fonts may not be embedded
["] Encrypt the document with a password

[ OK ][ Cancel ]

—

Run Optical Character Recognition (OCR) on all scanned documents.

You will need Adobe Acrobat Pro or the ability to OCR a document while scanning it into your
computer.

Click “Tools”.

Click “Recognize Text”.
Click “In this File”.
Click “OK”.

PwnbPE

Recognize Text

Pages
@ All pages

Current page

From page

Settings

Primary OCR Language: English (US)
PDF Output Style: Searchable Image
Downsample To: 600 dpi
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